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INTRODUCTION 
RadioMax is Telmar HMS Ltd's newest radio planning tool. It works with both full diary and full PPM 

data, as well as with diary ISST summary data. 

The program works with all demographics supplied by BBM, from the most common age and gender 

classifications to smaller, niche targets such as casual dining customers and other retail shoppers. 

The following is a screenshot of the Planning screen, the final screen showing a complete campaign's 

calculated statistics, including GRPs, impressions, reach percentage, frequency, ratings, CPM, and 

more. 

 

 

 

 

See next page for more details regarding the Survey Periods screen. 
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Have a look at the column of buttons down the left-hand side. These step your way through the 

program, building a campaign from start to finish. 

These buttons are: 

• Survey Periods - select the survey type, diary or PPM, from 

this screen. 

• Briefing - use this screen to set your campaign length in 

weeks, your data period if using PPM, and other client-

specific information, such as your campaign's name, your 

company, and other facts. 

• Targets & Dayparts - This screen gives you the opportunity 

to select pre-defined targets or dayparts, as well as the 

choice of building fully-customisable versions of each. With 

PPM you can specify the dayparts down to the minute level. 

You can select multiple targets and dayparts on this screen. 

• Markets - Once you have defined your targets, the next 

screen will show you the estimated audience in each market 

together with the number of actual panel respondents that 

qualify in your target range (ie Women 35-44, 74 

respondents in Hamilton). This screen allows you to select multiple markets at the same time. 

• Stations - After choosing your markets, you can select individual stations on this screen. When 

using diary data, the statistics shown will update automatically. With PPM, the user can update 

on-screen stats by clicking on the Recalculate switch. 

Station rankings are built into this screen by default. 

• Calendar - You can plot your campaign's spot delivery using this screen. You can vary the spot 

distribution week-to-week or by daypart. Also, this screen gives you additional options by 

allowing for blanket spot fills across a number of weeks or dayparts simultaneous, speeding 

input. 

• Planning - this is the final screen for your campaign, and includes detailed statistics for GRPs, 

reach percentage, frequency, impressions, costing and other info. This screen also incorporates 

a week-to-week report view, the ability to add or remove entire stations or specific dayparts from 

a run, and a GRP allocator that you can use to schedule given GRP levels that vary from week 

to week as needed. The allocator even allows the user to specify the individual dayparts and 

stations included in the distribution of spots. 
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Optionally, you will have a Radio Pane visible on the right. As you populate 

the different components of your campaign, your plan will be fleshed out 

accordingly. 

To hide or display this pane, go to the View menu at the top left and select 

either Normal (to display at all times), Minimized (to only display the pane 

when the mouse is over the right-hand side) or Off. 

 

Filtering: 

Additionally, most screens provide the ability to filter items by name. In the 

space above a given Target, Daypart, Market or Station screen, type the 

first few letters for your desired item. RadioMax will filter out items that do not 

match your entry. 

Column re-sort: 

All screens aside from the Calendar module provide the ability to sort data in 

ascending or descending order by toggling clicks on individual columns. 
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SURVEY PERIODS 

 

When you open the program RadioMax will start on the Survey Periods screen. All surveys are listed 

by their type, together with a descriptive label and the start and end dates for data collection. 

General comments: 

All radio data is sourced from the Bureau of Broadcast Measurement or BBM, which is a tripartite 

nonprofit organisation composed of radio and TV broadcasters, advertising agencies and larger 

advertisers. 

Diary surveys, both ISST and full types: 

Both diary survey types are compiled from radio listener panels in every measured market (typically, 

most cities and towns aside from the larger PPM markets). Panellists are given radio diary books in 

which they mark down their listened stations in 15-minute increments.  

Twice a year, these books are compiled from 13 weeks' worth of data. BBM further processes the full 

diary data into summary formats; these are called 'Diary ISST' surveys and are explained further below. 

Diary ISST Surveys: 

Summary ISST surveys, used with diary data, are listed under the section marked 'Diary ISST'.  

You can choose between ISST surveys where 'breakfast', 'daytime', 'drivetime' and so on are defined by 

the same time blocks for all stations, the so-called standard surveys, or you can select ISST surveys 

where every station uses its own definitions for 'breakfast', 'daytime', and so forth, these are the so-

called station dayparts' surveys.  

Full diary surveys: 
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These surveys are listed as 'MicroBBM'. They are collated using 13 weeks' data, like the ISST surveys. 

Further differences between the ISST and full diary surveys are explained under their relevant sections, 

such as Targets and Dayparts, Markets, etc. 

PPM surveys:  

These surveys are compiled from panels using Personal People-Meters, small pager-styled devices that 

work by recording an audio signal outside of the normal human range of hearing from radio broadcasts 

within the panellist's individual space. The PPM devices work automatically, without any human 

intervention, recording the day's radio signals. At night, the panellist returns the PPM device to a cradle 

that then transmits the recorded data to central BBM servers. 

Every four weeks, the latest collated PPM data is shipped to BBM subscribers. 

Telmar processes these weeks and adds them to each year's total.  

NB: The PPM year begins at the end of August / beginning of September. 

 

 

For all survey types: 

Once you have selected a survey, press Briefing to be taken to the next screen. 

WARNING: At this point, you haven't really selected anything beyond the survey, but let's say for 

the sake of an example you do proceed from here, and select stations, targets, dayparts, etc.  

If after choosing these you come back to Survey Periods and specify a different survey to your 

original choice, you will lose all previously-chosen modifications - all stations, dayparts, targets, 

and so forth.  

You will be warned by an alert if you choose a different survey. 

Let's start by using the Metered Respondent PPM data, listed under the section marked 'METER PPM'. 

Select the most recent survey available. 

Next, click Briefing. 
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Printing and/or exporting from the Survey Periods' screen: 

I. PRINTING THIS SCREEN 

To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. This will show you a table of all surveys from BBM, sorted in general groups 

by survey type (ie PPM, diary, diary ISST), then in reverse-chronological order starting with the most 

recent survey at the top of the section. 

On the Print Preview screen, then, you will see a menu line with File, View and Background. To print, 

select File, then the first Print listing if you want to see a proof before committing to paper, or the 

second Print item to send the file directly to your printer. 

If your printout does not appear, please contact Telmar Client Services in Toronto at (416) 487-2114. 

II. GENERAL PRINTING/EXPORTING COMMENTS 

You can change the margins shown, the orientation (portrait or landscape), the paper size (all North 

American and ISO sizes) via the menu bar shown underneath the File / View / Background menu line. 

Additionally, RadioMax enables you to select different output formats depending on your need. 

RadioMax will export to Excel format, and also has export options to send to comma-delimited format 

(CSV), plain-text (like CSV, with commas removed), HTML, MHT (mail transfer format), RTF (for 

compatibility with older word processors, while retaining formatting options), XLS and XLSX for former 

and current versions of Microsoft Excel, and finally a number of image formats, for the possibility of 

sending imaged copies of the reports. Available image formats include BMP, EMF (Encapsulated 

Windows Metafile), GIF, JPG, PNG and TIFF.  

RadioMax also currently has the ability to export to PDF, but this will be phased out in a future release, 

as office suites generally tend to read Excel files and export those directly to PDFs as needed.  

IIB. GENERATING EXCEL OUTPUT 

To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a.  On the far right of the icon bar, third from right, you will see an icon that looks like a 

floppy disk on top of a blank sheet of paper; this is the alternate Export Document option. From 

here, select XLS or XLSX.  
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BRIEFING: 

 
The only mandatory parts of this screen are located at the bottom. There, you will find two sets of fields, 

the first for the campaign length, and the second for selection of the active data period. 

For campaign length, you can choose individual start and end dates, or you can choose an overall 

number of weeks. Most users will stick to just programming the total number of weeks. 

For PPM, you also have another set of selection fields for the data underlying the calculations. Users 

can program in the overall weeks and even the precise dates to start and stop data calculations. For 

compatibility with calculations with non-Telmar radio applications, you can select start and end dates 

corresponding to official BBM data releases. Typically these will be for data periods of 4 or 13 weeks, as 

BBM releases PPM updates every four weeks, and also releases PPM ISST data summaries every 13 

weeks. The official schedule for these data releases is available from BBM's website ( http://bbm.ca ). 

Most of the other items on this screen are optional and provided for information purposes only. When 

you fill in fields such as Planner, Campaign and so forth, these are used later on when printing reports 

from the application.  

NB: Printing from the Briefing screen is discouraged as the summary information from the 

optional items are rather summarised on other screens instead. Please see other sections for 

more details. 
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TARGETS & DAYPARTS: 

 

I. Targets 

Here you will either select a predetermined target, such as women 35-49, or men 65+, or you can 

assemble your own targets from the New Target button at the top of the page.  

When you click on this, you are taken to a screen displaying the available demographic definitions, 

which go beyond age and gender into areas such as fast food consumption, retail purchasing, and other 

consumer behaviour items. 

Select your desired components from the left and transfer them to the right by clicking on Add in the 

middle column. When you have finished specifying your audience, fill in a descriptive title at the top and 

press OK. Your new target will be listed with an asterisk in the available targets screen.  

All custom targets will be available every time you open the same survey. In this fashion you can 

assemble a target library. 

You can select multiple targets simultaneously. 

NB:You must select at least one target before leaving the Targets and Dayparts screen. 

II. Dayparts 

Click on the small Dayparts tab immediately below the New Target icon, and as with the Targets 

section you will see some standard dayparts for use. When you switch to the Dayparts section the New 

item will change to read New Daypart; clicking it will display a dialogue box where you can enter a time 

frame. 
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This box takes the form DsDeT1T2, where: 

Ds = 2-day abbreviation for starting day ie Mo / Tu / We / Th / Fr 

De = 2-day abbreviation for end day as above 

T1 = Start time for the daypart; max 4-digits + AM / PM (lowercase) ie. 1217p 

T2 = End time for the daypart; max 4-digits + AM / PM (lowercase) ie. 1248p 

The final format is shown in an example on the popup screen, ie MoFr615a845p . 

The all-week daypart will be selected for you by default, just tick OFF the box to change it. Under PPM 

the all-week daypart is MoSu2a2a, under MicroBBM diary data the all-week default is 

MoSu5a1a. 

NB: When using MicroBBM diary data, you can select intervals of 15 minutes only. With PPM, 

you can specify precise minutes. 

Printing and/or exporting from the Targets and Dayparts' screen: 

a. PRINTING THIS SCREEN 

   To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. 

b. GENERATING EXCEL OUTPUT 

   To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a.  On the far right of the icon bar, third from right, you will see an icon that looks like a 

floppy disk on top of a blank sheet of paper; this is the alternate Export Document option. From 

here, select XLS or XLSX.  
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MARKETS: 

 
On entering this screen you will see a drop-down list of selected targets at the top of the page. A 

Calculate Markets button will be displayed in red next to it. In RadioMax, when conditions for a 

particular screen change, such as altered campaign stats, the Calculate button will change colour to 

red, indicating that the user should click it to update the displayed statistics.  

Press Calculate to show your demographic projected population and sample size. 

You can select multiple markets at the same time. 
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Printing and/or exporting from the Markets' screen: 

a. PRINTING THIS SCREEN 

   To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. 

b. GENERATING EXCEL OUTPUT 

   To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a.  On the far right of the icon bar, third from right, you will see an icon that looks like a 

floppy disk on top of a blank sheet of paper; this is the alternate Export Document option. From 

here, select XLS or XLSX.  
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STATIONS: 

 
Here you can select your campaign's stations. This screen works as a station ranker by default, 

displaying calculated statistics for your campaign's overall period (not the data period specified on the 

Briefing screen), ranked in descending order by AQH% or rating.  

However when you arrive on this screen for the first time, you will only see blanks - this is by design 

when using PPM data. Calculating the summary statistics on this screen is computationally expensive 

and increases with additional markets. For speed of access, where experienced users want to select 

their stations and move on to Calendar (where spot scheduling is handled), the RadioMax developer 

team have decided to simply show the station names only. 

When you land on this screen using MicroBBM diary surveys, these columns will all be populated 

accordingly. 

Across the top in drop-downs you will see available dayparts, targets, station types (ie commercial, AM 

or FM), a top X stations' selector, and two other items, a chooser icon and a Clear Selection button. 

Finally, a Calculate Station Rankings button may be shown if your screen has enough real estate. If 

not, follow the steps below. 

To maximise your available space, have a look at the button column (Survey Periods, Briefing, etc). 

On the top right of that column you will see a chevron facing left when the full buttons' text is shown. 

Click it, and the column will collapse to increase the centre panel's area.  

On the right, you may have the Radio Pane active; just minimize this section via the View menu if this is 

the case. 

Select your applicable daypart, then your target, and your desired station types, then click Calculate to 

update your figures. 
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The Top X stations' selector works by the user choosing the number of stations to select, then clicking 

the icon immediately to its right (resembling a downward stack). This switch will select the chosen 

number of stations by market. It is not possible to rank overall across all markets. 

You are now ready to plot spots delivered by week and daypart. 

Printing and/or exporting from the Stations' screen: 

a. PRINTING THIS SCREEN 

   To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. 

b. GENERATING EXCEL OUTPUT 

   To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a. On the far right of the icon bar, third from right, you will see an icon that looks like a floppy disk 

on top of a blank sheet of paper; this is the alternate Export Document option. From here, select 

XLS or XLSX.  
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CALENDAR: 

 
On this screen you will see a summary of all the stations and dayparts by market, listed in alphabetical 

order from top to bottom. Click inside a green cell to plot the spots for that daypart and that week. Hit 

enter when you have finished. 

You also have a number of useful fill options available once you have entered a spot total. 

Right-click on the cell. Note that you are permitted to specify a fill direction, be it up, down, left or right. If 

you highlight a block of cells, either in a row or column (ie across weeks or dayparts respectively) and 

right-click, you will be given the option to fill down or up (when highlighting a row) or left or right (when 

highlighting a column). 

You can also specify limits on fill behaviour - with some station and daypart combinations you might find 

yourself being asked to fill 'in this group only' - which will fill only the dayparts for that specific station or 

week, or you can tell RadioMax to fill 'across all weeks/dayparts/etc'. 

For longer campaigns where the available space is too constrained to fit all the weeks comfortably, you 

can grab the week-width slider bar at the top of the page and adjust all your visible weeks at once. 

  



C:\Documents and Settings\msavino.TELMARPEAKTIME.001\Desktop\manuals\radiomax-manual-rewrite-NoShadow.docx Page 17 

 

Printing and/or exporting from the Calendar screen: 

a. PRINTING THIS SCREEN 

   To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. 

b. GENERATING EXCEL OUTPUT 

   To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a.  On the far right of the icon bar, third from right, you will see an icon that looks like a 

floppy disk on top of a blank sheet of paper; this is the alternate Export Document option. From 

here, select XLS or XLSX.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<continues> 
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PLANNING:  

 
This screen will load all the components selected in previous sections and summarise them for you. By 

default, GRPs, impressions, reach, frequency and other data items are not calculated on entry to this 

screen. This is by design, so that you can modify the campaign as needed. 

As with other screens, the Recalculate button will be highlighted in red indicating the need to update 

the data shown by pressing it.  

After pressing the Recalculate button, and before you change any other statistics on this page, the 

Recalculate lettering will turn yellow, indicating that the figures as presented are current. 

Other items on this screen include, from left to right: 

1. Targets: You can switch between the selected targets you chose using the drop-down menu. 

2. Week[s]: You can switch between the default summary view (for the campaign overall), or each 

week individually using the drop-down menu. 

3. Columns: Click this button to choose which columns are displayed on the right-hand side of the 

screen. You can also save or load your preferred column layout to (or from) a customised file on 

the X drive, which is the default file storage location for all eTelmar applications.  

4. Recalculate: As above, if this is shown in red, you will need to update the onscreen figures by 

pressing this switch. If shown in yellow, your figures are the latest, most up-to-date available. 

This will change to red if you alter any of the green cells' contents. 

5. Week view: This is a specialised report. For more details, please see below under the Week 

View section. 
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User-input cells - in green: 

As outlined by item 4 above, green cells shown on the Planning screen indicate that a user can change 

these if desired. A detailed description of these cells and their functions follows - moving from left to 

right, we see: 

Spots: The total number of spots for the entire campaign - specific to your selected stations and 

dayparts - is displayed here. To alter it, just type in your new spot level. 

 

NB: Unless you have changed to specific weeks using the Week selector at the top of this 

section, any spot totals input for the daypart must be divisible by the number of weeks in your 

campaign, so that the spots are allocated equally for all weeks.  

 

Alternatively, you can switch back to the Calendar and input your different spot levels by week there too. 

When you return to the Planning screen you will see the totals updated accordingly. 

GRPs: You can also change the projected GRPs for the daypart(s). When you press Enter after filling in 

a new GRP level, the program will recalculate the needed number of spots based on the ratio between 

GRPs and spots required to achieve it. RadioMax will round off and try to accommodate the new level 

as necessary. 

Costs: There are 3 variations on costs available.  

1. Cost per spot (or Unit Cost) 

2. Cost per point (for your specified audiences) 

3. Cost per thousand (also for your specified audiences) 

 

 

 

 

 

 

 

 

 

 

 

<continues> 
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OTHER POSSIBLE MODIFICATIONS: 

 
STATION EXCLUSION: You can choose to hide a station. This suppresses a station's particulars from 

appearing on-screen (or in printed reports, and Excel output).  

NB: Suppressing a station does not remove it from the overall analysis, nor does it alter the 

displayed summary statistics shown in the bottom row of the program. Suppressed stations will 

be only displayed with their names visible on the Planning screen; no other statistics will be 

shown. 

To suppress a station (‘exclude’ it), right-click on the station's name on the left side of the screen.  

Exclusion will be the first option displayed. 

STATION INCLUSION: To reverse a station's exclusion, right-click on the suppressed station's name. 

The Include option will be the first one listed. Select it, and all dayparts will be returned to active status.  

STATION ADDITION OR REMOVAL: Adding or removing a station from the campaign: If your 

campaign changes you can add or eliminate individual stations from the campaign mix. To do this, right-

click on the station's name on the left-hand side. 

If adding, you will be able to choose from other stations in the same market. 

If removing, you will be asked to confirm the station's deletion from the campaign. Once approved, 

RadioMax will pull the station and, of course, all of its daypart and spot allocations.  

ADDING DAYPARTS: Right-clicking on either the station name or the daypart listing will display this 

option. All your dayparts, from the reference dayparts (supplied when you entered the dayparts' screen) 

to your own custom dayparts (shown with an asterisk) will be available. To construct new ones, click on 
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the onscreen New Daypart tab. RadioMax will then show you the same customised daypart builder 

shown on that screen. 

ADDING SPOTLENGTHS: Radio commercials are listed with a 30-second spotlength by default. 

However, if you wish, you can choose this option to change the daypart's commercial ad length. 

RadioMax does this by duplicating your original daypart to a new line. You can then change the 

spotlength directly. 

 

NB: RadioMax does not differentiate between spotlengths for the purposes of calculation; 

therefore your totals for a custom spotlength and the default 30-second length will be identical 

but on separate daypart rows. 

 

REMOVING DAYPARTS: RadioMax will ask you for confirmation before deleting a given daypart. 

Access this option by right-clicking on the daypart name on the left. 
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Week View: 
Further customisation on a week-to-week basis is also possible using the Week View report, which is 

listed further to the right on this screen. 

 

When you click the button marked Columns you will see a pop-up divided into 3 main sections, top to 

bottom, with a left and right side to each. 

These sections correspond to the columns shown on screen, top for the left-side columns and bottom 

for the right-side detail columns. 

In all cases, the available columns are listed on the left side of the popup, and your displayed columns 

listed on the right side. 

The first section, Static items, list things like your chosen days and dayparts, and ratings (AMA% or 

AQH% depending on the data type being used). With the exception of calculating ratings, most of these 

items will not change from week-to-week, hence its label. 

The second section, Independent items - week columns, allows you to specify which columns will 

display individual week-to-week data. Spots are supplied by default (thereby mimicking the Calendar 

and extending its structure), and you can also add costs (unit and CPP), reach percentages, 

frequencies, GRPs, and impressions. 

The last section, Independent items - total columns, shows the overall effect of the campaign and lists 

the same variables as in the second section. This format mimics the default Planning report. 

Select your additional columns as desired and click OK; this will show the report on-screen. When you 

close this screen, the program should retain the formatted columns you have added for future use, and 

return you to the Planning screen. 
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GRP Allocation: 

 
To access this new feature of RadioMax, right-click on the Market label on the left side of this screen (in 

the centre pane), and select GRP Allocation. 

On this screen you will see a summary of all the chosen stations for that single Market, together with 

summaries of the daypart and a series of blank boxes for the calculation of daypart GRPs.  

To start, decide whether or not you wish to have the Allocator Go Over (and exceed) stated GRP limits, 

or Stay Under to set upper bounds for the achieved spot ratings. 

Next, using and holding down the left mouse button, mouse over the individual dayparts to select them 

for allocation. The easiest way to do this is hold down the mouse button and sweep the mouse from left 

to right. 

Then, decide if you want to allocate GRPs by each week individually, or over the entire course of the 

campaign. If individually, enter each week’s limits as desired. If done over the course of the campaign, 

individual weeks will be allocated. 
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Printing and/or exporting from the Planning screen: 

a. PRINTING THIS SCREEN (AND ITS VARIANTS) 

   To print a listing of the available data surveys, click on File in the top left-hand section of the program, 

and select Print Preview. 

b. GENERATING EXCEL OUTPUT 

   To export to Excel, take the following steps. 

1. From the File menu, select Print Preview.  

You can choose from two ways to get the same generated Excel output. Both are listed below. 

You can also select other formats for export as listed above. 

2. On the popup that appears, select Export Document, then from the submenu that pops up, select 

XLS or XLSX. 

2a.  On the far right of the icon bar, third from right, you will see an icon that looks like a 

floppy disk on top of a blank sheet of paper; this is the alternate Export Document option. From 

here, select XLS or XLSX.  


